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Installation
Double click Softsite Lite.msi to begin installation

You should see this screen for a brief second or so
M

-,

Windows Installer

| Preparing to install...

Cancel

The installer window is displayed . Select Next to advance the installation
15! softsite Lite

Welcome to the Softsite Lite Setup
Wizard

The installer will guide you through the steps required to install Softsite Lite on your computer.

Click "Mest'" to continue.

WARMING: Thiz computer program is protected by copyright law and international reaties.
Unautharized duplication or distribution of this program, or any partion of it, may result in severe
civil or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Lancel

Select the default destination and click Next to continue (Using default
destination is advised and will be used in the rest of this manual)

Select Next again to start installation.
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15 Softsite Lite

Select Installation Folder

The installer will inztall Softzite Lite in the following folder.

To inztall in this folder, click "Mest". To install to a different new or existing folder. enter one
below or click “Browse".

Folder: C:\Program Filez\S oftsite Lite’ Browsze...

“You can install the software on the following drives:

olume Digk Sizi
(=T 926Gt
4 ] il | [)]

’ Cancel ] ’ Previous ] | Mext |

Select Close to exit and finalize the installation
1 Softsite Lite

Installation Complete

Softzite Lite has been sucessfully installed.

Click "Close" to exit.

Setup

Double Click the Icon Shortcut to Softsite Lite.exe
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The Main Window Launches

Main Window Layout
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1. Main Window
» This window is seen upon launching Softsite Lite application
2. Start Button
» This button when pressed starts cameras streaming and/or
recording
3. Setup Button
» This button when pressed will open up setup window Note: only
works when application is not streaming video
4. Archive Button
» Launches softview when pressed
5. Video Window
» Window where video is seen

6. Minimize Button
» When pushed minimizes window
7. Maximize Button

» When pushed maximizes window
8. Close Button
» When pushed closes application Note: only works when application
is not streaming video

Click Setup
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Setup Window Layout
B Softsite32 Lite: Setup Panel m==)

Camera Caption
=Undefined Camera 1=
= Undefined Camera 2 =

(* Simple

= Undefined Camera 3 =
= Undefined Camera 4 =

" Advanced
3

™ Metwork Scan

Camera Info | Network InfDI Recording IV‘/

Image Preview

[~ Enable Video Stream
Clear Al |
[ Stretch to Fit

Camera Name: I
Device MFG: I
Device Model: I

Video Port: I Defaults |
Query Device |

1. Setup Selection
» Allows selection of 3 methods of Setup
o Simple
o Advanced
o Network Scan
2. Camera Caption
> Displays cameras title and which camera is selected and for
which window
3. Stream Setup
» Where camera setting are inputted for streaming
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Simple
Allows addition of

one camera at a time, while adding only pertinent

information, than allowing software to query camera for other information

Camera Info

HY Softsite32 Lite: Setup Panel

mE=]

(* Simple
" Advanced

™ Metwork Scan

Camera Caption
=Undefined Camera 1=
=Undefined Camera 2 =

= Undefined Camera 3 =
=Undefined Camera 4 =

Camera Name:

@®.
® —

Video Port:

Camera Info | Metwork InfDI Recurd\ngl

Enable Video Stream

Stretch to Fit

Device MFG: I
Device Model: I

Query Device |

1. Enable Video Stream
» When checked enables cameras for streaming
2. Clear All

» Clears all information for selected camera(camera
caption)
3. Stretch to Fit
» When checked takes streams larger than 320x240

and

»

stretches them down to fit 320x240

Update

» Saves current information Note: must be clicked on
each separate tab
5. Video Port
» Number of video port when using a video server
6. Camera Name
» Name desired for the camera selected
7. Device MFG
» Field populates with the manufacturer after the device
is queried Note: See 10
8. Device Model
> Field populates with the model after the device is
gueried Note: See 10
9. Defaults
» Resets default settings
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10. Query Device
» Checks devices against list of supported devices, and
add information such as manufacturer, model,
password Note: uses camera default information. If
using other than default info, manually change the
fields
11. Image Preview
» Double click to receive an image preview of camera.
Note: only works if IP address is already input

Network Info
B Softsite32 Lite: Setup Panel (=
Camera Caption
) = Undefined Camera 1=
& simple 1 2 = Undefined Camera 2 =
 Advanced = Undefined Camera 3=
4 = Undefined Camera 4 =
" MNetwork Scan
. Camera Info i M | Recurmngl
\ Device Info: Copy |
IP Address: |
Root ID: I
Root PV I
IP Port: I
MAC Address: I
Update | Query Device | i

1. IP Address
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> |IP Address is typed here to communicate with the
camera Note: Fields in yellow are required
2. Root ID
» Login name for the camera usually the administrator
3. Root Password
» Password for the login name above
4. Mac Address
» Unigue number that all cameras have, field populates
when query device is clicked
5. Update
» Updates all information on current tab or page work is
being done on
6. Copy
» Copies information the in the Device Info window to
the clipboard
7. IP Port
» |If camera is set to any port other than 80 change it
here
8. Query Device
» Pings device with IP address, retrieves all information
regarding camera including Mac address, server type,
default user name and password if one isn’t specified
9. Device Info
> Displays info received from camera on a query

Recording
B Softsite32 Lite: Setup Panel =JoE

Camera Caption

LiteCam1
= Undefined Camera 2 =

* Simple

= Undefined Camera 3 =
= Undefined Camera 4 =

A

v Record 5 FPS MNoiseFiter 4 [ +| I 40
[¥ Motion Detection Sensitivity 1 I 'I I 200

Wore Less

" Advanced

\ Update

1. Record
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®

» Check this box for interval recording
Motion Detection
» Check this box for motion recording
Update
» Updates all information on current tab or page work is
being done on
FPS
» Type the requested frames per second you wish to
record, Maximum of 5
Noise Filter
» Adjusts the noise filter to ignore noise in the picture
for motion detection
Sensitivity
» Adjusts the sensitivity of the motion detection settings

Advanced

B, Softsite32 Lite: Setup Panel

=1

" Simple
+ Advanced:

" Network Scan

Setting

Camera Caption

LiteCam1

= Undefined Camera 2 =
= Undefined Camera 3 =
= Undefined Camera 4 =

Value

CamBaseName

CameraMame
~camRecFes

D
CamRootPW
CamSnapShotString
CamStreamstring
Devicelodel
DizplayDownSampleindex
lpAddress
MacAddress
PerformMotionDetection
RecordBasePath
RGB_FitterLewvel
RGB_MotienThreshold
StretchVideoToFit
ThDelay

|Server1

x

Update ‘ :: ’

Mote: CamB aseMame and

CameraMame are required fields for

Recording ta function propery. Lite will place archives in the

Fath created by

FecordBasePathhCamBaseN ame\CameraMame:

1. Settings
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» Individual settings are set here for each camera, most
of these settings are discovered via the query device
button. A definition list of these settings are in the
appendix.

2. Value

» Where each of the individual values are changed for

the individual settings
3. Update

» Updates all information on current tab or page work is

being done on

Network Scan
B Softsite32 Lite: Setup Panel =JoE

i~ Simple
~

111.111.111.108
IP Address Base:  [111.111.111 Scan All |

Uncheck All |
Devices Online:

@ .

Http Port: I 20
Copy to Clipboard | . Save |

1. Uncheck All
> Uncheck all of the devices selected
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2. Devices Online
> All the devices found after a scan has been run
3. Copy to Clipboard
» Copies all text in the devices online box
4. Address Base
» The IP range scanned for devices
5. Scan All
» When pushed the application scans the Address base
for devices online, which can be cameras and servers
but also computers.
6. Current Address
» The address of your computer
7. Http Port
» Default HTTP port of the scan
8. Save
» Click to save the selected servers

B Softsite32 Lite: Setup Panel =JoE

{" Simple
" Advanced
* Network Scan

111.111.111.108

IP Address Base: S All
111.111.111 Scan : ™ Detaied
Uncheck Al EERERRREREENT
. 3
Devices Onling: 5 T TS
111.111.111.1, Unknown, wrong port or root ID/PW?
111.111.111.1041, Unknown, wrong port or root ID/PW? 1
111.111.111.100, Unknown, wrong port or root ID/IPW? 2 ’7
111.111.111.104, Unknown, wrong port or root ID/PW?
111.111.111.105, AXIS, AXIS 2420, 00:40:2C:5E:A5:B0 3
4
Clear
Http Port: 20

Copy to Clipboard Save

i

1. Populated Device List
» List populates after using the discover button
2. Targeted Devices

» Field populates when you select devices from the list
3. Detailed button
» When selected a detailed list appears in the list
4. Discover button
» When button is pressed the application finds which
devices are supported by displaying server and model
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General Use

Main Window

After going through and setting up cameras you will see this view
B softsite Lite M= <)

Start Setup  Archivs

To start the cameras streaming click Start

You will see the cameras you've added displaying
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1. Stop Button
» Button to stop streaming and access setup
2. Title Bar
» Name of the camera, clicking twice will bring up more
information regarding the camera
3. Recording Button
» Indicates either motion recording or full time
recording. Also can be pressed to bring up quickview
4. Motion Activity Gauge
» Displays level of motion in the current picture, red
triggers recording
5. FPS
> Indicates speed of stream in frames per second

Archive Viewing
Quickview

To Bring up quick view press the recording button
‘This will instantly show you the most recent captured video

JDS Digital Security Systems
http://Softsite32.com
-15-




B 5532 Quick View

(M=%

Options Display‘,

Directory I Date / Time I

= ¢ [50003666]

=

5 Archives

=4 Senver

£ LiteCam 1
32005

® ® 9

1. Video Search Options

>

2. Directory
>

Play
Pause

o0k

>

™~

>

You can use a directory tree or a date/time to search
through archives (you may need to resize the window
to show the bottom and the individual archives)

Tree / Date and Time

Depending on which tab you have chosen you will
see either a directory tree or a calendar

Play in Reverse
Play Speed

Displays the current speed playback is occurring in

Slider Bar

Allows quick movement through archive and also
movement using the scroll wheel of the mouse

8. Video Window

» Where the images are displayed
9. Recorded Image size
» The size the image was recorded in
10.Options — Different options can be selected here
B8] 5532 Quick View ®=(X
Options  Display
Refresh Archive
Copy Image to Clipboard
Prirplrlmagge ’ j
Copy JPX Stream to Disk B
5 Archives
£ servert
E311] LiteCam-1
£42005
(o
w1 ax |

2
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» Refresh Archive — adds video that has been recorded

since the record button has been pushed

Copy Image to Clipboard — Takes image from the
video window and allows it to be pasted into other
applications

Print Image — Prints image to default printer

Copy Jpx Stream to Disk - Copies the current file to
another location on the hard drive

11.Display — Display options for the application can be selected

___here
B 5532 Quick View M=%
Options | Display I
. v Show Tree
Eliecthn Allows Image Resizing
=Jc = Playback Speed 4 :]
5 o JPX Statistics u
23 Archives
4 senvert
E311] LiteCam 1
=§ 2005
ehov
"J“J"_‘H’( |
» Show Tree — Displays the tree or the date and time
depending on the method of retrieval selected
> Allow Image Resizing — Allows image to be stretched
to a larger size for playback
» Playback Speed — Allows playback speed to be
changed
» JPX Statistics — Displays frame count and size of

current archive
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